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Predgovor

Autodesk 3ds Max 2008

Dobro dosli u svet Autodeskovog programa 3ds Max 2008. 3ds Max je softverski
paket za 3D animacije i modelovanje, razvijen u kompaniji Autodesk Media and
Entertainment. Masovno se koristi u arhitekturi, projektovanju igara, vizuelizaciji
dizajna i izradi umetnickih vizuelnih efekata. Skup alatki za animaciju likova, Bi-
ped, opcije za modelovanje poligona i dodeljivanje tekstura, ¢ine ga idealnom plat-
formom za rad 3D modelera i animatora. Intuitivno korisni¢ko okruZenje i alatke
za organizovanje rada u 3ds Maxu 2008, olaksavaju posao stru¢njacima za vizueli-
zaciju projekata.

Knjiga 3ds Max 2008: sveobuhvatni vodi¢ opisuje nove i upecatljivije osobine
programa Autodesk 3ds Max 2008. Ovaj sveobuhvatan udzbenik postupno vodi
animatore i dizajnere kroz sve mogucnosti programa. Jednako je posvecen potre-
bama pocetnika i iskusnih korisnika 3ds Maxa. Imajuci na umu razli¢ite potrebe
korisnika, u ovoj knjizi su prvo predstavljene osnovne osobine 3ds Maxa 2008, a
potom se postepeno prelazi na opisivanje naprednijih 3D modela i animacija.
Knjiga je pisana poput udzbenika i zasniva se na prakti¢cnom radu, pa mozete uciti
kada vam odgovara i sopstvenim tempom.

Ova knjiga ¢e vam pomoci da oslobodite svoju kreativnost, napravite zadivlju-
juce 3D modele i animacije, i svoje zamisli s lakocom pretvorite u stvarnost. Kori-
snike programa vodi kroz Sirok spektar animacija preko primera rastuce slozenosti,
obilja ilustracija i detaljnih vezbi.

Najvaznije osobine ovog udzbenika su:

e Vezbe zasnovane na realnim projektima

Autor knjige je prihvatio udzbenicki pristup i u¢enje uz rad. Oko 35 realnih 3D

animacija i projekata 3D modelovanja upotrebljeno je za vezbe u ovoj knjizi.

Zahvaljujudi tome, korisnik mozZe da poveZe lekcije iz knjige sa stvarnim mode-

lima. U knjizi se nalazi i pedesetak zadataka zasnovanih na realnim projektima.
e Saveti i napomene

Dodatne informacije vezane za temu ponudene su u obliku saveta i napomena.
¢ Ciljevi ucenja

Na prvoj strani svakog poglavlja ukratko su izloZene teme koje ono obraduje.
e Odeljak o alatkama

Svako poglavlje pocinje saZetim informacijama o alatkama 3ds Maxa.
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Test za samostalnu proveru znanja, pitanja i zadaci

Svako poglavlje se zavr§ava testom za samostalnu proveru znanja koji korisnici-
ma omogucava da provere steceno znanje. Odgovori na pitanja iz testa nalaze
se na kraju poglavlja. Pored toga, na kraju poglavlja nalaze se i pitanja i zadaci
koje predavaci mogu koristiti pri proveri znanja polaznika kurseva.

Bogato ilustrovan tekst

Tekst ove knjige je ilustrovan sa oko 1500 crteza i slika ekrana.

Oznake u tekstu

Napomena
@ Dodatne informacije vezane za temu.
N

. Savet. Korisni saveti o obradenoj temi.



Uvod u Autodesk
Ads Max 2006

Ciljevi ucenja

Kada proucite ovo poglavije, moci cete da:

« Pratite tok rada na projektu u 3ds Maxu.

« Zapocnete nov projekat u 3ds Maxu.

« Koristite komponente prozora 3ds Maxa.

- Koristite kontrole za izradu ili menjanje objekata.
- Koristite precice u 3ds Maxu.

« Prilagodavate precice.

- Prilagodavate boje elemenata u 3ds Maxu.

= deijwatdd ol o
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UVOD U AUTODESK 3ds Max 2008

Dobro dosli u svet Autodeskovog 3ds Maxa. Autodesk 3ds Max je napredan soft-
ver za izradu nepokretnih ili animiranih 3D modela i objekata. Pomocu njega
mozete napraviti realisticne scene menjanjem objekata, dodeljivanjem mapa i ma-
terijala, podeSavanjem atmosfere u sceni, dodavanjem svetala, kamera itd. Pre
nego $to pocnete da radite u 3ds Maxu, trebalo bi da steknete osnovna znanja o
raznim alatkama i komandama dostupnim u tom programu. U ovom poglavlju
cete upoznati osnovne osobine Autodeskovog 3ds Maxa.

TOK RADA NA PROJEKTU

Da biste poceli da radite u 3ds Maxu, prvo morate napraviti modele ili scenu, do-
deliti im mape i materijale, podesiti svetla i kameru, animirati objekte u sceni i ra-
sterizovati scenu da biste videli konacan rezultat.

POCETAK RADA U 3ds Maxu

Pre svega, instalirajte Autodesk 3ds Max na svoj racunar. Ikonica precice Auto-
desk 3ds Max 2008 32-bit automatski ce biti napravljena na radnoj povrsini nakon
instaliranja softvera. Dvaput pritisnite tu ikonicu da biste pokrenuli 3ds Max. Dru-
gi nacin da pokrenete 3ds Max jeste da upotrebite precice s palete poslova. Da bi-
ste to uradili, iz menija palete poslova odaberite Start > All Programs > Autodesk
> Autodesk 3ds Max 2008 32-bit > Autodesk 3ds Max 2008 32-bit, kao na slici 1-1.

Sistem ce se pripremiti za pokretanje 3ds Maxa tako $to ce ucitati sve potrebne
datoteke. Ako prvi put pokrecete Autodesk 3ds Max, otvorice se okvir za dijalog
Customer Involvement Program (slika 1-2). Taj okvir za dijalog vas poziva da
ucestvujete u prikupljanju povratnih informacija od korisnika, Customer Involve-
ment Program (CIP). Ako Zelite da se ukljucite u CIP, pritisnite radio-dugme Yes,
I agree and I want to participate (Recommended) i potom dugme OK. Ako ne,
odaberite dugme Cancel. Ukoliko se pridruzite CIP-u, 3ds Max ¢e Autodesku slati
podatke kao §to je broj sesija prekinutih zbog problema sa stabilno$¢u sistema, ak-
cija uvoZenja i izvoZenja, pokrenutih akcija iz menija itd., kada je sistem povezan sa
Internetom. Svi podaci koji se Salju Autodesku odnose se na upotrebu softvera i
koristi ih kompanija da popravi svoj proizvod. Okvir za dijalog Customer Involve-
ment Program mozZete pokrenuti i kasnije tako $to cete s trake menija odabrati
Help > Customer Involvement Program.

Kada se neophodne datoteke ucitaju, otvorice se prozor 3ds Maxa i okvir za di-
jalog Welcome Screen (slika 1-3). U okviru za dijalog Welcome Screen prikazana
su video-uputstva koja ce vas voditi kroz osnove okruzZenja za rad u programu. Da
biste pokrenuli uputstvo, pritisnite odgovarajuce dugme u tom okviru za dijalog.
Uputstvo ce biti prikazano u prozoru Essential Skills Video unutar okvira za dija-
log. Da biste izaSli iz okvira za dijalog Welcome Screen, pritisnite dugme Close.
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Napomena
Da biste mogli da gledate video-uputstva, na racunaru mora biti instaliran pro-
gram za reprodukovanje QuickTime.

OTVARANIJE NOVE DATOTEKE U 3ds Maxu

Da biste u 3ds Maxu otvorili novu datoteku, s trake menija odaberite File > New.
Drugi nacin je da pritisnete tastere CTRL+N; otvorice se okvir za dijalog New Sce-
ne (slika 1-4). U tom okviru za dijalog, podrazumevano je izabrano radio-dugme
New All Tada ce biti uklonjen sav sadrzaj iz tekuce scene i bice otvorena nova da-
toteka. Pritisnite dugme OK i prikazace se nova datoteka.
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Slika 1-1 Pokretanje 3ds Maxa pomocu precice na paleti poslova

Objekte iz tekuce scene moZete upotrebiti u novoj datoteci. U okviru za dijalog
New Scene pritisnite radio-dugme Keep Objects da biste u novoj datoteci zadrzali
objekte iz tekucde scene. Medutim, kada izaberete to radio-dugme, svi kljucevi ani-
macije i veze izmedu objekata bice uklonjeni. MoZete pritisnuti radio-dugme Keep
Objects Hierarchy da biste zadrzali i objekte i veze izmedu njih. Medutim, u tom
slucaju ce biti obrisani kljucevi animacije.

Pre nego $to otvorite novu datoteku u 3ds Maxu, preporucuje se da ponovo po-
krenete program. Tako cete sve parametre za novu datoteku vratiti na podrazu-
mevane vrednosti. Da biste vratili podrazumevane parametre u 3ds Maxu, s trake
menija odaberite File > Reset; otvorice se okvir za dijalog 3ds Max (slika 1-5) s pi-
tanjem da li zaista hocete ponovo da pokrenete 3ds Max. Pritisnite dugme Yes.
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—
Customer, Involvement Program | X |

Customer Involvement Program

As a beginner, expert, or someone in between, yvou can play a key role in
helping us design software to meet your needs and exacting standards,

Haw it wiorks

‘When you participate, we automatically collect anonymous information about
wour syskem configuration and how you use your Autodesk products,
Periodically, this information will be sent to us, Mo personal information is
collected and no one will contact you,

Simply turn it on once For all of your Autodesk products, and continue working
without inkerruption. You can return anytime ko change your setting by clicking
on the Customer Involvement Pragram link under the Help menu.

Read the Customer Involvement Program privacy policy to learn how
Aukodesk uses your information

" “es, | agree and | want to participate (Recommended)
& Mo, | don't want to participate at this time

Flease note; Participating customers who submit error reports to Autodesk
might not be anonymous, Learn more. ..

¥ Rermind me in 7 daps ()3 | Cancel |

Slika 1-2  Okvir za dijalog Customer Involvement Program

Welcome Screen

Autodesk

User Interface Overview Modifying Objects

2 6

Viewport Navigation Matenals
3 \7
Creating Objects Animation
>
4

Transforming Objects Access the "\ |! ’: '\

V' Show this dialog at startup Cloge |

Slika 1-3 Okvir za dijalog Welcome Screen

S druge strane, ako iz menija File odaberete opciju New, nova datoteka e biti ot-
vorena bez menjanja prethodno zadatih parametara.
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Options:
\‘.p ¢~ Keep Objects and Hierarchy
- ?
£ Keep Objects \Q Do you really want to reset?
& Mew Al

Cancel |

Slika 1-4  Okvir za dijalog New Scene Slika 1-5 Okvir za dijalog 3ds Max

KOMPONENTE PROZORA 3ds Maxa

Prozor 3ds Maxa sastoji se od razli¢itih komponenata, prikazanih na slici 1-6. Nji-

hovo objasnjenje sledi.

- Autodesk 3ds Max 2008 - Not for Resale - Display : Dir. ..

© Untitled, - Project Folder: C:\Documents and Settings\cad\by Documents\3dsmax:
Fle Edt Topls Group Views Creste Modfiers reactor Animation GraphEdtors Renderng Customize MAXSCrpt Help Tentades

SO AaF T [’ S el :hrlqw\

[ ol 5.5 e
T Fi
i t J i Komandni pano —L | #[#4@| B[ T |
Naslovna traka - Traka menij [0 v & o %
Standard Primitives -
: Potpaleta—= hject Type
Glavna paleta alatki—— T
Box Cone
Sphere GieoSphere
Cylinder Tube
Tons Pyrarnid
i i Teapol Plane
== b
[ HemeandColor ],
Left Perspective { [ .
Kontrole za kretanje u prozoru za prikaz
r— Prikaz koordinata
: Kontrole za reprodukovanje animacije
ermkepsk,' r—Traka za pradenje
izat animacije
y |« Kontrole za zadavanje kljuéeva —
LL L animacije
< /100" > ]
= T TITITTT T mummmmmungp\mmHB\DHHHmwHmulmu|||\|nm\m1$0
None Selecte & mlx | [@id=100 | Auto Keylﬁe\etled 1«\ an [&] m [ wei Q &a )
|[ ik or click-and-drag to select chiects % [ Time Tag Setkey| of*  KeyFilters, wi [[o Bl =8 A

Slika 1-6 Razliéite komponente ;brozom 3ds Maxa

Traka menija

Traka menija (engl. menu bar) nalazi se neposredno ispod naslovne trake (engl. tit-
le bar) i sadr7i razne padajuce menije (slika 1-6). Neki padajuci meniji su standard-
ni za Windowsovo okruZenje, na primer File, Edit, Help itd., dok su drugi
specifi¢ni za 3ds Max, na primer Create, Modifiers, Character, reactor, Animati-
on, Graph Editors, Rendering, Customize itd. Naslov svakog padajuceg menija
nagovestava njegovu namenu. Kada pritisnete naslov menija, 3ds Max otvara od-
govarajuci padajuci meni. Svaki meni sadrZi skup komandi. Tri tacke iza imena
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komande u padajucem meniju znace da ce se biranjem te komande otvoriti okvir
za dijalog. Strelica udesno iza imena komande znaci da ¢e se, kada na komandu
postavite kursor, otvoriti kaskadni meni. Pored toga, desno od imena nekih ko-
mandi u padaju¢im menijima navedene su i precice s tastature (slika 1-7).

Palete alatki

U Autodeskovom 3ds Maxu razne komande su dostupne i na paletama alatki
(engl. toolbars) u vidu dugmadi ili alatki. U prozoru 3ds Maxa podrazumevano c¢e
biti prikazana samo glavna paleta alatki, Main Toolbar. Medutim, mozZete prikaza-
ti i druge palete alatki, na primer reactor, Snaps, Axis Constraints, Extras itd. Pa-
lete alatki po potrebi moZete premestati, menjati im veli¢inu i pretvarati ih u
plutajuce palete alatki. Da biste otvorili neku paletu alatki, desnim tasterom misa
pritisnite prazan prostor na glavnoj paleti alatki i otvorice se priru¢ni meni sa
imenima svih paleta, kao na slici 1-8. Odaberite ime palete alatki i ona ce biti pri-
kazana u prozoru. Prikazanu paletu alatki sakricete tako §to cete ponovo izabrati
njeno ime iz tog priru¢nog menija.

=l Customize MAXScript  Help

Render... F10
Environment.. . g
Effects...
Light Tracer. ..
Render To Texture... 1} R
adiosity. .,
Batch Render, .. v 3 o,
Exposure Contral... ,!" @ | @5 &_ @(“'

Raytracer Settings... Lighiting analysis... : = ]
Raytrace Global Include/Exclude. .. Customize...
mental ray Message Window. . . v Command Panel

v Main Toolbar
Mater!al Editor... £l Axis Constraints
Material/Map Erowser... Layers
Video Post... v reactor

Extras
Shiow Last Rendering Render Shortcuts
Panorama Exparter. ., Snaps
Print Size Wizard. .. Animation Layers
RAM Player. ., EBrush Presets
Slika 1-7 Otvoren padajuci meni Slika 1-8  Prirucni meni sa spiskom
Rendering s trake menija sakrivenih paleta alatki

Glavna paleta alatki omogucava brz pristup mnogim alatkama i okvirima za di-
jalog, kao s§to su Undo, Select and Link, Unlink Selection, Select Object, Material
Editor itd. Ona je usidrena neposredno ispod naslovne trake. Paleta alatki reactor
usidrena je na levoj strani ekrana. Ona omogucava pristup alatkama reactor, kao
$to su RB Collection, Wind, CL Collection itd. U narednim poglavljima upoznace-
te alatke dostupne na raznim paletama.
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Komandni pano

Komandni pano, Command Panel, podrazumevano je usidren na desnoj strani
prozora 3ds Maxa. Na komandnom panou nalazi se Sest kartica: Create, Modify,
Hierarchy, Motion, Display i Utilities (slika 1-9). Najveci deo alatki za modelo-
vanje i animiranje nalazi se na tim karticama. Alatke s komandnog panoa koriste
se za izradu, menjanje i animiranje objekata. Svaka kartica ima nekoliko potpaleta
sa opcijama za izradu ili menjanje objekata. Potpalete se mogu sazimati i proSiri-
vati. U nastavku je opisano Sest kartica komandnog panoa, Command Panel.

W
Val

Command Panel rﬂ

R
(0™ % &|o 2 %

IStandard Frimitives LI

| - Object Type |
= AutoGrid
Box Caone
Sphere GeoSphere
Cylinder Tube
Torug Pyramid
Teapot Flane

[- Mame and Calar |‘|

| st
Slika 1-9 Pano Command Panel

Kartica Create podrazumevano je izabrana. Alatke s kartice Create koriste
se za izradu objekata, postavljanje kamera, svetala itd.

Kartica Modify se koristi za menjanje izabranih objekata u prozoru za pri-
kaz, tako Sto se menjaju parametri, primenjuju razni modifikatori i ureduju

objekti koji su dostupni za menjanje, kao Sto su izmenljive mreZice (engl. editable
mesh) ili izmenljivi poligoni (engl. editable poly).

s
@

@
T

[E

Kartica Hierarchy koristi se za upravljanje vezama u hijerarhiji, zglobovima
1 inverznom kinematikom.
Kartica Motion koristi se za upravljanje kontrolerima animacije.

Kartica Display koristi se za sakrivanje i ponovno prikazivanje objekata u
prozoru za prikaz.

Kartica Utilities koristi se za pristupanje raznim pomocnim programima koji
sluZe kao dodatni moduli u 3ds Maxu, na primer, reaktorima (engl. reactors).

Napomena

Palete Command Panel, Main Toolbar i reactor moZete ukloniti s nji-

hovih usidrenih poloZaja i postaviti bilo gde na ekranu. Da biste to ura- E]
dili, postavite kursor na paletu alatki koju hocete da premestite i on ce

dobiti oblik strelice s dva preklopljena pravougaonika. DrZite pritisnut levi ta-
ster misa 1 prevucite paletu alatki na Zeljeno mesto.
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Prozori za prikaz

Kada pokrenete 3ds Max, otvorice se podrazumevano korisnicko okruzenje. Ono
se sastoji od cetiri prozora za prikaz iste veli¢ine, okruZenih alatkama i komanda-
ma (slika 1-6). Ti prozori za prikaz (engl. viewports) obelezeni su kao Top (prikaz
odozgo), Front (prikaz spreda), Left (prikaz sleva) i Perspective (prikaz perspekti-
ve). Prozori za prikaz se u 3ds Maxu koriste za izradu 3D scena. Pored toga, oni
omogucavaju posmatranje scene iz razli¢itih uglova. Kada napravite objekat u
prozoru za prikaz, u prozorima Top, Front i Left videcete ortografske prikaze ob-
jekta odozgo, spreda i sleva.

Veli¢inu prozora za prikaz promenicete ako povucete tacku u kojoj se seku gra-
ni¢ne linije prozora za prikaz. Da biste vratili pocetnu veli¢inu, desnim tasterom
pritisnite tacku preseka grani¢nih linija i otvorice se priru¢ni meni (slika 1-10).
Odaberite opciju Reset Layout; pocetna veli¢ina prozora za prikaz bice vracena.

Slika 1-10 Prozori za prikaz sa izabranom opcijom Reset Layout

Jedan od cetiri prozora za prikaz bice istaknut Zutim okvirom i to je aktivan
prozor za prikaz (engl. active viewport). U jednom trenutku samo jedan prozor za
prikaz moze biti aktivan. Da biste aktivirali neki drugi prozor za prikaz, pritisnite
miSem unutar njega. Prozor za prikaz moZete aktivirati i tako $to cete ga pritisnuti
desnim tasterom miSa i tada ce biti ocuvana selekcija objekata.

U donjem levom uglu svakog prozora za prikaz nalazi se tripod svetskog koor-
dinatnog sistema (engl. world-space tripod), kao na slici 1-11. Tripod ima tri ose, X,
Y i Z, koje su prikazane crvenom, zelenom, odnosno plavom bojom. Taj tripod se
uvek odnosi na svetski koordinatni sistem (engl. world coordinate system), bez obzira
na lokalni koordinatni sistem.
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Perzpective

,— MreZa

y\f/x ——Tripod svetskog koordinatnog sistema

Slika 1-11 Tripod svetskog koordinatnog sistema w prikazu perspektive

Vazno je imati na umu to da lokalni koordinatni sistem definiSe lokalni polozaj
objekta u sceni. Za razliku od lokalnog, u svetskom koordinatnom sistemu koriste
se fiksne ose za definisanje svih objekata u svetskom prostoru.

Svaki prozor za prikaz sadrzi mrezu (slika 1-11). MreZza (engl. grid) podseca na
milimetarski papir na kom se sve linije seku pod pravim uglom. Rastojanje izmedu
linija mreze mozete menjati. MreZe su u svim prozorima za prikaz pomocno
sredstvo za vizuelizovanje razmaka i rastojanja pri izradi objekata. Pored toga, one
predstavljaju i konstrukcionu ravan za izradu i poravnavanje objekata. Mreze
mozete koristiti i kao referentni sistem pri upotrebi kontrola za prianjanje prili-
kom poravnavanja objekata. Da biste u prozoru za prikaz sakrili mrezu, pritisnite
taster G.

Kada desnim tasterom miSa pritisnete oznaku nekog prozora za prikaz, otvo-
rice se priruc¢ni meni. Opcije iz tog menija koriste se za menjanje raznih aspekata
aktivnog prozora za prikaz. MoZete zameniti podrazumevani prozor za prikaz bilo
kojim drugim dostupnim prikazom, kao $to su Bottom (prikaz odozdo), Right (pri-
kaz zdesna) itd. Da biste to uradili, postavite kursor na oznaku prozora za prikaz
u gornjem levom uglu i pritisnite desni taster misa; otvorice se priru¢ni meni. Oda-
berite opciju Views; otvorice se kaskadni meni, kao na slici 1-12. Odaberite ime
prozora za prikaz koji Zelite da otvorite.

Isti priru¢ni meni i kaskadne menije njegovih opcija moZete upotrebiti da biste
definisali vrstu sen¢enja u prozoru za prikaz. Opcije su Smooth+Highlights, Wire-
frame, Edged Faces, Smooth, FacetHighlights, Facets, Flat, Lit Wireframes,
Bounding box itd., i pomocu njih dete promeniti sencenje.

Vec znate da se na ekranu vide cetiri prozora za prikaz iste veli¢ine. Medutim,
po potrebi moZete promeniti njihovu konfiguraciju. Da biste to uradili, s trake me-
nija odaberite Customize > Viewport Configuration; otvorice se okvir za dijalog
Viewport Configuration. Pomocu opcija iz tog okvira za dijalog konfigurisacete
prozore za prikaz. Da biste promenili osnovnu konfiguraciju prozora za prikaz,
odaberite karticu Layout (slika 1-13). Na kartici Layout mozZete zadati metodu po-
dele prozora za prikaz. Na vrhu okvira za dijalog navedeno je 14 vrsta konfigura-
cija. Izaberite konfiguraciju i pritisnite dugme OK; prozori za prikaz bice otvoreni
u skladu sa odabranom konfiguracijom.
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Slika 1-12  Prirucni meni koji se otvara kada desnim tasterom misa pritisnete
oznaku prozora za prikaz

Viewport Configuration

Slika 1-13  Okvir za dijalog Viewport Configuration

] Napomena
L : Konfiguracijom prozora za prikaz definisan je raspored prozora za prikaz, tj. ob-

lasti za crtanje na ekranu.
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Kontrole za kretanje u prozoru za prikaz

U donjem desnom uglu prozora 3ds Maxa nalaze se razne alatke (slika 1-14). To su
kontrole za kretanje u prozorima za prikaz, a koje ce kontrole biti prikazane, zavisi
od izabranog prozora za prikaz. Na primer, ako je izabran prozor za prikaz Came-
ra, odgovarajuce alatke videce se u kontrolama za kretanje. Te alatke su objasnje-
ne u narednim poglavljima.

Kontrole za reprodukovanje animacije

U prozorima za prikaz, alatke koje se koriste kao kontrole za reprodukovanje ani-
macije prikazane su levo od kontrola za kretanje (slika 1-15). Pomocu njih se upra-
vlja animacijom u aktivnom prozoru za prikaz. Pored toga, pomocu tih alatki
mozete zadati ukupan broj kadrova, duzinu i druge parametre animacije.

Kontrole za zadavanje kljuceva animacije
Alatke koje se koriste kao kontrole za zadavanje kljuceva animacije prikazane su
levo od kontrola za reprodukovanje animacije (slika 1-16). One se koriste za
ulaZenje u razne reZime animacije i izlaZenje iz tih reZima.

| Q & :ﬁ: 53 o] | -l El 13 |bh| — Auta Key ISeIected vl
|> éﬂ-? .5‘9‘ LU ||D £| & Set Key ;r" F.ey Filters. .. |

Slika 1-14 Kontrole za Slika 1-15 Kontrole za Slika 1-16 Kontrole za
kretanje u prozoru za prikaz  reprodukovanje animacije zadavanje kljuceva animacije

Traka za pracenje animacije

Traka za pracenje animacije (engl. track bar) postavljena je izmedu vremenskog kli-
zaca i statusne trake (slika 1-17). Na njoj je prikazana vremenska osa (engl. timeli-
ne) i broj kadra.

Vremenski kliza¢

Vremenski kliza¢ (engl. time slider) prikazuje tekuci kadar i ukupan broj kadrova u
tekucem vremenskom segmentu (slika 1-17). MoZete pogledati svaki kadar anima-
cije tako Sto cete u njega povuci vremenski kliza¢. Vremenski segment je ukupan
opseg kadrova koje moZete pregledati pomocu klizac¢a. Podrazumevano, on obu-
hvata opseg od 0 do 100. Opseg mozete zadati u okviru za dijalog Time Configu-
ration, o kom cete uciti u narednim poglavljima.

Vremenski klizat

< 0/100 |>]

TTTTTTTTITITTITTTTIT I ITTITIT I T 0T Traka za pracenje
o E]] 1|J3 2!0 3!0 }animacijg :

Slika 1-17  Deo trake za pracenje animacije i viemenskog klizaca
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Statusna traka

Na statusnoj traci (engl. status bar) prikazane su razne informacije o sceni i aktivnoj
komandi (slika 1-18). Na dnu ekrana nalazi se traka s porukom (engl. prompt line)
koja prikazuje informacije o aktivnoj komandi ili alatki. Na vrhu statusne trake
nalazi se tekstualno polje koje se naziva statusna linija. Statusna linija prikazuje
broj trenutno izabranih objekata (tekudi skup izabranih objekata). Alatka Selec-
tion Lock Toggle na desnoj strani statusne linije koristi se za zakljucavanje skupa
izabranih objekata. U oblasti za prikaz koordinata i transformacije prikazane su
koordinate X, Y i Z kursora ili trenutno izabranog objekta. U tu oblast mozZete
uneti vrednosti transformacije prilikom pomeranja, menjanja velicine ili rotiranja
izabranih objekata.

Prekidac
Selection Lock Prikaz koordinata Prikaz parametara
- | ¢
Statusna I|n|ja—| I | |— mreZe
[ None Selects & [2] ] | z] | Grid=10.0
| Click or click-and-drag to select objects l@ _@ | Add Time Tag
_ L Oblast vremenske
Traka s porukom oznake
Dugme Alatka

Adaptive Degradation Communication Center
Slika 1-18 Statusna traka

Oblast za prikaz parametara mreZe nalazi se desno od oblasti za prikaz koordi-
nata. U njoj Cete videti veli¢inu mreZe. Oblast vremenske oznake (engl. time tag), is-
pod oblasti za prikaz parametara mreze, koristi se za dodavanje tekstualnih oznaka
bilo kojoj tacki na vremenskoj osi animacije. Pritisnite unutar oblasti za vremensku
oznaku i bice prikazane opcije Add Tag i Edit Tag. Pomocu njih ¢ete dodati, od-
nosno menjati tekstualne oznake u bilo kojoj tacki na vremenskoj osi animacije.
Alatka Communication Center, levo od oblasti vremenske oznake, pruza informa-
cije o dostupnosti servisnog paketa za nadogradnju, savete za rad u programu i
druge podatke za nadogradnju programa, i to ukoliko je racunar povezan sa Inter-
netom. Levo od te alatke nalazi se dugme Adaptive Degradation koje sluzi za po-
pravljanje performansi prozora za prikaz ukoliko radite na nekoj sloZzenoj sceni,
tako Sto privremeno smanjuje vernost prikaza objekata. Zahvaljujuci tome, pokreti
i transformacije objekata u prozoru za prikaz postaju glatkiji. Da biste aktivirali tu
mogucnost, desnim tasterom misa pritisnite alatku Adaptive Degradation; otvo-
rice se okvir za dijalog Viewport Configuration. U njemu je podrazumevano ot-
vorena kartica Adaptive Degradation (slika 1-19). Po Zelji promenite parametre na
toj kartici i pritisnite dugme OK.

KONTROLE

U Autodeskovom 3ds Maxu postoje posebne kontrole koje moZete koristiti da bi-
ste pravili ili menjali objekte u prozorima za prikaz, a njihov opis sledi.
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Potpaleta

Potpaleta (engl. flyout) jeste meni u okviru neke dugmadi, a sadrzi alatke sa slicnim
funkcijama. Potpaleta Snap Toggle prikazana je na slici 1-20. Dugmad s malim
trouglom u donjem desnom uglu sadrZe potpaletu. Zadrzite pritisnuto takvo dug-
me i otvorice se potpaleta (slika 1-20).

Viewport Configuration

]
ﬂ
]
]

- J |

Slika 1-19 Kartica Adaptive Degradation u okviru za dijalog
Viewport Configuration

Mali trougao

Potpaleta
Slika 1-20 Potpaleta

Prirucni meniji

Meniji koji se u 3ds Maxu otvaraju desnim tasterom mi$a omogucavaju brz pristup
uobicajenim komandama vezanim za tekucu selekciju. Kada neki objekat pritisne-
te desnim tasterom misa, otvorice se viSedelni priru¢ni meni (engl. quad menu) kao
na slici 1-21. Na desnoj strani nekih opcija iz viSedelnog priru¢nog menija nalaze
se strelice. Kada pritisnete tu strelicu, otvorice se kaskadni meni, kao na slici 1-21.
Ukoliko desnim tasterom mi$a pritisnete unutar prozora za prikaz, otvorice se
priru¢ni meni (engl. shortcut menu) kao na slici 1-22.
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Parametri prianjanja

Prianjanjem se ogranicava kretanje kursora na odredeni deo objekta ili mrezZe. Za
zadavanje prianjanja dostupna su cetiri dugmeta na glavnoj paleti alatki: Snaps
Toggle, Angle Snap Toggle, Percent Snap Toggle i Spinner Snap Toggle. Ako
desnim tasterom miSa pritisnete dugme Snaps Toggle, Angle Snap Toggle ili Per-
cent Snap Toggle, otvorice se okvir za dijalog Grid and Snap Settings (slika 1-23).
Tu mozete izabrati razne delove objekata ili mreZe uz koje ce kursor prianjati. Ko-
mandu za prianjanje ukljucicete ili iskljuciti tako §to cete pritisnuti taster S ili dug-
me Snaps Toggle.

ViSedelni priruéni meni

Slika 1-21 Visedelni prirucni meni i kaskadni meni

Slika 1-22  Prirucni meni koji se otvara kada desnim tasterom misa
pritisnete prozor za prikaz
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Units Setup

© Grid and Snap Settings

J'

g
]
] |
| ]
] ]
] |
| |
=0
Slika 1-23  Okvir za dijalog Slika 1-24  Okvir za dijalog Units Setup
Grid and Snap Settings

Ako zadrzite pritisnuto dugme Snaps Toggle, otvorice se potpaleta. Na njoj se
nalaze alatke 2D Snap, 2.5 Snap i 3D Snap koje mozZete odabrati da biste zadali op-
ciju prianjanja za kursor.

Podesavanje mernih jedinica

PodeSavanjem parametara mernih jedinica u 3ds Maxu, zadaju se jedinice koje ce se
koristiti pri merenju geometrije u sceni. Podrazumevano se u 3ds Maxu koriste ge-
nericke merne jedinice. Parametre mernih jedinica moZete promeniti preko pada-
judeg menija Customize. Da biste to uradili, s trake menija odaberite Customize >
Units Setup; otvorice se okvir za dijalog Units Setup (slika 1-24). U tom okviru za di-
jalog podrazumevano je odabrano radio-dugme Generic Units. Po potrebi izaberite
neko drugo radio-dugme u oblasti Display Unit Scale tog okvira za dijalog i pritis-
nite dugme OK; vrednosti na svim broja¢ima u 3ds Maxu bice izmenjene u skladu sa
izabranom opcijom.
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. -
Zadavanje razmaka mreze ® Grid and Snap Settings FoX
Da biste zadali rastojanje izmedu linija Sraps | Options | HomeGrid | UserGids |
mreZe prikazane u prozorima za prikaz, s r Girid Dimension

.. . . . Grid Spacing:l 10.0 ﬂ
trake menija odaberite Customize > Grid g i =

. ., X K Major Lines every Mth Grid Llne.l‘ID J

and Snap Settings; otvorice se okvir za di- Perspective View Grid Extent [T 3]
‘Jalog (%rld an.d Snap Settn‘lgs. U nJemu [V Inkibit Grid Subdivision Below Grid Spacing
Odaberlte kartlcu Home Grld (Shka 1_25) [V Inkibit Perspective View Grid Resize
U oblasti Grid Dimensions, na brojacu ~ Dynamic Update
Grid Spacing zadajte veli¢inu najmanjeg & ActiveViewport € All Viewports

kvadrata mreZze. Vrednosti na brojacima
bice izrazene u zadatim mernim jedinica-

ma. Preko brojaca Major Lines every Nth Slika 1-25 Kartica Home Grid
Grid Line zadajte broj kvadratica izmedu okvira za dijalog
glavnih linija mreZe. Preko brojaca Per- Grid and Snap Settings

spective View Grid Extent zadajte veli¢cinu
mati¢ne mreZe u prikazu perspektive.

Podrazumevana mreZa prikazana u svim prozorima za prikaz kada se 3ds Max
pokrene, naziva se mati¢na mreZa (engl. home grid).

U oblasti Dynamic Update podrazumevano je izabrano radio-dugme Active
Viewport. Koristi se za azuriranje aktivnog prozora za prikaz u skladu s novim
vrednostima koje ste zadali na broja¢ima okvira za dijalog Grid and Snap Settings.
Izaberite radio-dugme All Viewports da bi svi prozori za prikaz bili istovremeno
aZurirani u skladu s novim vrednostima na brojac¢ima u okviru za dijalog Grid and
Snap Settings.

PRECICE S TASTATURE

U 3ds Maxu moZete koristiti tastaturu da biste aktivirali neke alatke. Tastaturne
precice (engl. kot keys) omogucavaju brzi i efikasniji rad, a objasnjene su u nastavku.

Glavna paleta alatki
Precice koje se mogu koristiti za pokretanje alatki s glavne palete (Main Toolbar)
navedene su u nastavku.

H Aktivira alatku Select by Name

S Aktivira alatke s potpalete dugmeta Snaps Toggle
A Aktivira alatku Angle Snap Toggle
CTRL+SHIFT+P  |Aktivira alatku Percent Snap Toggle

M Aktivira alatku Material Editor

SHIFT+Q Aktivira alatku Quick Render
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Kontrole za kretanje u prozoru za prikaz
Precice kojima se pokrecu kontrole za kretanje u prozoru za prikaz navedene su u
nastavku.

ALT+CTRL+Z Obavlja akciju alatke Zoom Extents
ALT+W Aktivira alatku Maximize Viewport Toggle
ALT+Z Aktivira alatku Zoom

CTRLAW Aktivira alatku Zoom Region

CTRL+P Aktivira alatku Pan

Okretanje tockica miSa

Uvecava ili umanjuje prikaz u aktivnom prozoru za
prikaz

CTRL+R

Aktivira alatku Arc Rotate

SHIFT+Z

PoniStava dejstvo alatke Zoom ili Pan

ALT+ drzanje pritisnu-

Obavlja akcije alatke Arc Rotate

tog srednjeg tastera misa
i pomeranje misSa

Naredne precice se koriste za menjanje oznaka u prozorima za prikaz:

Aktivira viSedelni priru¢ni meni u prozoru za prikaz

Aktivira prozor za prikaz odozgo (Top)

Aktivira prozor za prikaz spreda (Front)

Aktivira prozor za prikaz sleva (Left)

Aktivira prikaz perspektive (Perspective)

Aktivira prozor za prikaz odozdo (Bottom)

e EIEIEEE RS

Aktivira prozor za namenski prikaz (User)

Kontrole za reprodukovanje animacije
Precice kojima se aktiviraju kontrole za reprodukovanje animacije navedene su u
nastavku.

N Aktivira alatku Toggle Autokey Mode
Home Aktivira dugme Go To Start

End Aktivira dugme Go To End

\ (obrnuta kosa crta) |Aktivira dugme Play Animation

ESC Aktivira dugme Stop Animation

, (zarez) Aktivira dugme Previous Frame

. (tacka) Aktivira dugme Next Frame
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© Customize User Interface

Keyboard | Toolbars | Guads | Menus | Colors |

Group: IMain Ui 'l ¥ Active

Category: IAII Commands LI

Action | Shortcut | -~ Hatkey: I
$ 100w Bulb — :
$ 100w Halogen Bulb Assigned to: |

¥ 214 Halogen Bulb
¥ 35w Halogen Bulb
¥ 404 Bulb
4t Cove Fluorescent [w...
4ft Pendant Fluorescent..
¥ 504 Halogen Bulb
¥ 604 Bulb
¥ 75w Bulb
¥ 804 Halogen Bulb
[ &bout reactor...
Absalute
Activate 3ds bax
Activate Grid [Context]

Activate Grid Object . )
Activate Home Grid I Overides Active

Activate HomeGrid [Con... Dielay To Override: W ﬂ
ActiveShade Floater

ActiveShade Quad
ActiveShade Viewport {adibe Kepboard Chart )
Adaptive Degradation T... 0
Adaptive Perspective G...

Azzign Femove

Load... | Save... | Reset |

|€

Slika 1-26  Okvir za dijalog Customize User Interface

MENJANJE PRECICA S TASTATURE

U 3ds Maxu moZete sami zadavati precice s tastature. Da biste to uradili, s trake
menija odaberite Customize > Customize User Interface. Otvorice se okvir za di-
jalog Customize User Interface (slika 1-26), a u njemu ¢e podrazumevano biti ot-
vorena kartica Keyboard. Izaberite komandu s padajucih lista Group i Category;
ispod padajuce liste Category bice prikazan spisak odgovarajucih akcija. Izaberite
neku akciju sa spiska, pa u polje Hotkey unesite precicu koju Zelite da dodelite iza-
branoj akciji. Pritisnite dugme Assign i izabranoj akciji ¢e biti dodeljena uneta
precica.

MENJANJE BOJA KORISNICKOG OKRUZENJA

Program 3ds Max omogucava da menjate boje programskog okruzenja. MoZete
promeniti boju gotovo svih elemenata u okruzenju. Da biste to uradili, s trake me-
nija odaberite Customize > Customize User Interface i otvorice se istoimeni okvir
za dijalog. U njemu otvorite karticu Colors. S padajuce liste Elements odaberite
kategoriju elementa okruZenja. Ispod te padajuce liste bice prikazan spisak odgo-
varajucih elemenata.
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Izaberite neki element sa liste i pritisnite uzorak boje desno od padajuce liste
Elements; otvorice se okvir za dijalog Color Selector. Izaberite novu boju i priti-
snite dugme OK da biste zatvorili okvir za dijalog Color Selector.

Revert Color File

'E IF wou continue, you will lose all changes yvou made to your menus since you starked this session,
L]

Continue?

Slika 1-27 Okvir za dijalog Revert Color File

Izabranu boju moZete zameniti fabricki podeSenom bojom. Da biste to uradili,
pritisnite dugme Reset na dnu okvira za dijalog Customize User Interface; otvo-
rice se okvir za dijalog Revert Color File (slika 1-27). Pritisnite dugme Yes i u polju
sa uzorkom boje bice prikazana podrazumevana boja.

Napomena
Zbog jasnijeg Stampanja, pozadina w ovoj knjizi je bela. Medutim, radi jasnijeg
N

prikazivanja, ponegde su koriscene i druge seme boja.
Stavise, na nekim slikama je radi jasnoce iskljucen prikaz mreZe.
U nekim vezbama ce se od vas traZiti da pronadete slike i maxove datoteke s Web

prezentacije CADCIM. Zbog toga, pre nego sto pocnete da radite veZbe, preuzmite
slike i maxove datoteke s Web prezentacije do koje vodi sledeca veza:

http://www.cadcim.com/max_2008/max_2008.him

Test za samostalnu proveru znanja
Odgovorite na sledeca pitanja i zatim uporedite svoje odgovore sa onima datim na
kraju poglavlja:
1. Pomocu koje se od narednih alatki popravljaju performanse prozora za prikaz
prilikom rada na sloZenoj sceni tako $to se vernost prikaza nekih objekata pri-
vremeno smanjuje?

(a) Adaptive Degradation (b) Potpaleta Snaps Toggle
(c) Mirror (d) Nijedna od navedenih

2. Preko koje se od navedenih kartica upravlja kontrolerima animacije?
(a) Motion (b) Display
(c) Hierarchy (d) Nijedna od navedenih

3. U kom se od navedenih okvira za dijalog zadaje rastojanje izmedu linija mreze
prikazane u prozorima za prikaz?

(a) Customize User Interface (b) Grid and Snap Settings
(c) Units Setup (d) U svim navedenim
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10.

. Koja se od navedenih precica koristi za aktiviranje alatke Pan?

(a) CTRLA+P (b) SHIFT+Z
(c) CTRL+A (d) CTRL+W

se nalazi na dnu ekrana i prikazuje informacije o aktivnoj koman-
di ili alatki.
Okvir za dijalog prikazuje video-uputstva koja vam pomazu pri
upoznavanju osnovnog radnog okruzenja softvera.

Vecina 3ds Maxovih alatki za modelovanje i animaciju moZe se aktivirati sa
Sest kartica komandnog panoa Command Panel. (Da/Ne)

. Podrazumevano okruZenje 3ds Maxa sastoji se od tri prozora za prikaz iste ve-

licine, okruzenih alatkama i komandama. (Da/Ne)

. U 3ds Maxu moZete promeniti boju gotovo svih elemenata okruzenja.

(Da/Ne)
Kontrole za reprodukovanje animacija upravljaju prikazom i kretanjem u
prozorima za prikaz. (Da/Ne)

Resenja testa za samostalnu proveru znanja
1.a,2.a,3.b,4. a, 5. traka s porukom, 6. Welcome Screen, 7. Da, 8. Ne, 9. Da,
10. Ne
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